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Tutorial	adobe	premiere	pro	cs6	bahasa	indonesia	pdf

Terdapat	3	cara	untuk	membuat	cinema	bar	atau	blackbar	di	Premiere	Pro.	Ikut	langkah	mudahnya	dalam	tutorial	membuat	black	bar	premiere	pro	ini!	Read	more	Cara	membuat	split	screen	di	premiere	pro,	tutorial	membagi	video	menjadi	dua	bagian	dengan	menggunakan	adobe	premiere	pro	bahasa	indonesia.	Read	more	Teknik	yang	sangat	cocok
untuk	digunakan	sebagai	judul	intro	pada	video	travel	/	vlog,	yaitu	text	background	video	yang	berbeda	untuk	setiap	hurufnya.	Read	more	Teknik	Color	Correction	dan	Color	Grading	merupakan	duo	kritis	yang	akan	membangun	suasana	scene	agar	dapat	mengarah	ke	Cinematic	Looks.	Read	more	Belajar	cara	membuat	Title	di	adobe	premiere	pro	dan
menambahkan	text	dengan	teknik	yang	mudah.	Contohnya	Title	untuk	nama,	Subtitle,	dan	juga	Credit	Title.	Read	more	Cara	menambahkan	transisi	di	adobe	premiere	pro.	Transition	&	Burn	Effects	yang	terlihat	professional	diantara	clip	dan	footage.	Mudah	dan	menarik!	Read	more	Pengenalan	Effects	menarik	yang	ada	di	adobe	premiere	pro.	Kita
akan	membahas	secara	singkat,	apa	aja	sih	effect	yang	sudah	include	didalam	Premiere	Pro.	Read	more	Untuk	menjadi	video	editor	sejati	tentu	kita	harus	mengetahui	basic	audio	compositing,	karena	audio	musik	dalam	video	sangat	lah	penting	untuk	membangun	Read	more	Premiere	Pro	adalah	salah	satu	software	video	editing	populer	di	dunia,
dirancang	khusus	untuk	memudahkan	semua	video	editor	dengan	berbagai	fitur	menarik.	Read	more	Cara	Edit	Video	Menggunakan	Adobe	Premiere	Pro	–	Sudah	tidak	asing	lagi	software	editing	besutan	dari	Adobe	System	banyak	pengguna.	Pasalnya	dari	fitur	Adobe	Premiere	Pro	sudah	dapat	menunjang	para	content	creator	untuk	sekedar	membuat
video,	bahkan	sampai	project	film.Jika	Anda	ingin	menjadi	seorang	penggiat	video	kreatif	professional	memang	sangat	cocok	menggunakan	software	adobe	premiere.	Pada	penggunaan	memang	sangat	mudah	dari	user	interface	yang	sangat	simpel	dan	elegan	menurut	kami.Apa	saja	yang	akan	di	dapat	dalam	software	ini	?	Anda	bisa	menambahkan
color	correction,	animation,	effect,	transition,	include	Adobe	Audition	atau	hal	yang	kebutuhan	lainnya	untuk	editor	video.	Jujur	saja	kami	saat	ini	dalam	mengedit	video	lebih	sering	menggunakan	Adobe	Premiere	Pro.Tidak	lupa	segi	hal	resolusi	sudah	support	pengeditan	4K	(Ultra	HD),	keren	bukan	?	Paling	penting	sih,	menurut	ogasite	adalah
penggunaan	color	correction	untuk	mempercantik	tampilan	warna	video	yang	akan	dihasilkan	terlihat	natural	dan	indah	dipandang.Namun,	pada	tutorial	mengedit	video	kali	ini	kami	tidak	akan	menjelaskan	lebih	detail	sampai	color	correction,	melaikan	mengedit	video	untuk	pemula	atau	pengenalan	awal.	Bagaimana	sih	edit	video	di	Adobe	Premiere
dan	apakah	mudah	dimengerti	atau	tidak.Hal	yang	paling	mendasar	disiapkan	adalah	Anda	mempunyai	source	video,	baik	itu	Anda	mengambil	sendiri	dengan	kamera	smartphone,	kamera	dan	lainnya	atau	menyiapkan	video	dari	sumber	yang	sudah	ada.	Setelah	itu	Anda	harus	mempunyai	softwarenya	bisa	lihat	disini	menggunakan	versi	trialnya.Cara
Edit	Video	di	Adobe	Premiere	Untuk	PemulaAda	beberapa	hal	sangat	penting	dari	penggunaan	Adobe	Premiere	Pro	yang	memang	harus	Anda	ketahui,	dalam	segi	aspek	spesifikasi	komputer	yang	Anda	gunakan	saat	ini.	Ogasite	sangat	merekomendasikan	menggunakan	komputer	dengan	RAM	minimum	4GB,	dan	Prosessor	Intel	Celeron	dual	Core	atau
yang	setara.	Pastinya	spesifikasi	diatas	rekomendasi	tentu	akan	lebih	bagus	untuk	dijalankan,	apalagi	sudah	menggunakan	storage	ssd.1.	Buka	Adobe	Premiere	Pro	di	komputer	Anda,	Pilih	“New	Project”	untuk	memulai	editing	video.	Lalu	Anda	bisa	menambahkan	Nama	Project	itu,	Lokasi	penyimpanan	file	project,	dan	settingan	lainnya.2.	Sebelum
melakukan	editing,	kita	membuat	Sequence	(	Ctrl	+	N	)	atau	dalam	istilah	lain	ini	di	ibaratkan	seperti	scene.	Belum	paham	juga	?	atau	gini	deh,	Anda	punya	video	Episode	1,	Episode	2,	dst..Nah	Anda	bisa	menyimpan	ke	3	episode	tersebut	dalam	1	Project	file	Adobe	Premiere.	Ketika	dibuka	Misal	Sequence	1	adalah	file	editing	episode	1,	Sequence	2
dari	file	editing	episode	2,	dan	seterusnya.3.	Pada	tahapan	Suquence	ini	bagian	yang	paling	penting	menurut	kami,	kenapa	?	Karena	kita	akan	memilih	resolusi	editing.Kita	tinggal	sesuaikan	dengan	file	video	yang	dimiliki,	misal	Anda	mempunyai	video	Resolusi	720p	atau	1080p	dengan	30	FPS	(	Frame	rate	per	second	)	dan	silahkan	memilih	1080p30
atau	720p30	tergantung	video	yang	Anda	punya.Sebentar,	bagaimana	cara	mengetahui	ukuran	resolusi	dengan	Fps	itu	?	Pergi	ke	lokasi	file	klik	kanan	pada	video	dan	Properties	>	Details	>	disana	terdapat	informasi	yang	sudah	mencakup	dari	resolusi	hingga	Fps.File	yang	kami	gunakan	adalah	720p30	–	Silahkan	Anda	bisa	mengganti	nama
Sequence	1	misal	dengan	Episode	1	atau	Scene	1	terserah	ya.	Lalu	tekan	saja	OK.4.	Ini	merupakan	tampilan	awal	dari	Adobe	Premiere	Pro,	Anda	bisa	menggunakan	fitur	yang	tersedia	dibawah	ini.	Salah	satunya	paling	penting	adalah	Timeline	(Sequence)	>	dimana	untuk	menyatukan	video	yang	akan	kita	edit	dan	menambah	effect	ataupun
suara.Import	Video	Kedalam	Project5.	Rasanya	percuma	saja	kalau	belum	import	video	kedalam	Adobe	Premiere	Pro,	apa	yang	mau	kita	edit	?	Kalau	tidak	ada	videonya.	Silahkan	Anda	menuju	menu	File	>	Import	(	Ctrl+I	)	dan	pilih	video	sesuai	lokasi	yang	kamu	simpan	ya.6.	Setelah	mengimport	video	kedalam	project,	secara	otomatis	Adobe
Premiere	akan	menyimpan	video	Anda	di	kolom	Project	–	Nama	Project	seperti	dibawah	ini.7.	Bahan	video	yang	anda	ingin	edit	sudah	ditampung	di	kolom	Project,	Tugas	Anda	sekarang	adalah	memindahkan	video	kedalam	timeline	dengan	cara	Drag	and	Drop	video.8.	JIka	anda	berhasil	melakukan	Drag	and	Drop	Video	akan	tampil	seperti	dibawah	ini,
Kita	bisa	melakukan	beberapa	kali	dengan	sesuai	kebutuhan.9.	Mengenal	fungsi	tools	dalam	timeline	yang	menunjang	kebutuhan	editing,	akan	tetapi	tidak	akan	semua	digunakan	dalam	pengeditan,	patokannya	dalam	penggunaan	mouse	Anda.Pemotongan	Video	didalam	Timeline10.	Untuk	pemotongan	durasi	video	berada	di	timeline,	Anda	bisa
menggunakan	tools	yang	telah	tersedia	di	timeline	dengan	Trim	tool.	Atau	juga	Anda	bisa	memotongnya	dengan	cara	arahkan	cursor	ke	ujung	video	sampai	seperti	tanda	yang	didalam	kolom	berwarna	merah,	lalu	tinggal	drag	saja	sesuai	keinginan.11.	Adapun	kita	setelah	drag	ujung	video	yang	akan	dilakukan	bisa	mengurangi	durasi	video	ataupun
memulihan	video	tersebut	yang	telah	kita	potong	tadi.12	.Kita	busa	perhatikan	terdapat	dua	kotak	pada	kolom	V1	mendakan	Video	1,	dan	A1	adalah	Audio	1,	yang	dimana	ini	saling	keterkaitan.	Anda	bisa	menghilangkan	audio	dengan	cara	klik	kanan	>	Unlink13.	Secara	default	atau	bawaan	sebelum	di	unlink,	video	dan	audio	ketiga	di	geser	secara
bersamaan	tergeser,	sedangkan	setelah	di	unlink	akan	bisa	seperti	dibawah	ini	dan	Anda	bisa	menghapusnya.14	.Lakukan	penyusunan	video	secara	bertahap	dengan	sebagaimana	gambar	dibawah	ini,	Pada	kolom	A1	atau	Audio	anda	bisa	menambahkan	sebuah	musik	ataupun	Sound	FX	sesuai	keinginan.15.	Kita	pindah	kedalam	kolom	Project	>	Klik
Kanan	>	Import	(Ctrl	+	I)	audio	yang	sesuai	keinginan	Anda.	Pada	cara	ini	kita	akan	menambahkan	musik	dalam	edit	video	di	Adobe	Premiere.Menambahkan	Musik	atau	Audio	di	Timeline16.	Bisa	dilihat	kolim	dengan	berwarna	hijau	adalah	sebuah	audio	atau	musik	yang	kami	tambahkan	didalam	timeline.	File	musik	atau	audio	tersebut	terdapat	dari
import	yang	telah	saya	siapkan	dan	seperti	cara	sebelumnya	adalah	di	Drag	an	Drop.17.	Audio	terlalu	panjang	bukan	?	Anda	bisa	menggunakan	Trim	Tools	untuk	memotong	audio	ataupun	video	yang	terlalu	lebih.	Perhatikan	dalam	kolom	berwarna	merah,	merupakan	tanda	audio	yang	akan	dipotong.Menambahkan	Effect	di	Adobe	PremiereKita	akan
sedikit	mempercantik	opening	video	dengan	menambahkan	suatu	effect	yang	telah	di	sediakan	di	Adobe	Premiere.1.	Anda	bisa	menuju	menu	Windows	>	Effect	(	Shift	+	7	)	>	dan	bisa	dilihat	nomor	2	merupakan	kolom	dari	Effect	tersebut.2.	Untuk	menambah	effect	pada	video,	kita	akan	gunakan	yang	sering	dipakai	pada	umumnya	yaitu	Effect	Cross
Disolve,	Lalu	anda	tinggal	drag	and	drop	ke	bagian	setiap	ujung	video.3.	Jika	sudah	di	drag	ke	dalam	timeline	maka	hasilnya	seperti	ini.	Oh	iya,	Anda	juga	bisa	mengatur	effect	sesuai	keinginan	dalam	hal	durasinya.Membuat	Text	atau	Tulisan	di	Adobe	PremiereText	atau	tulisan	merupakan	sebuah	element	yang	sangat	penting	dalam	pembuatan	video,
karena	akan	menambahkan	suatu	informasi	yang	dapat	dilihat	oleh	orang	lain.Oleh	karena	itu,	pada	tahapan	ini	kami	akan	menambahkan	text	atau	title	di	video	yang	kita	sedang	edit	ini.1.	Silahkan	Anda	pilih	File	>	New	>	Legacy	Title	(	Untuk	Adobe	Premiere	Versi	CS6	atau	CC	2014	pada	bagian	menu	title	)2.	Untuk	mengisi	nama,	SIlahkan	bebas
terserah	Anda	dan	“OK”.3.	Pilih	Text	dan	Klik	pada	bagian	layar	hitam,	dan	Anda	bisa	mengetik	text	pada	bagian	nomor	2.4.	Untuk	contohnya	seperti	ini	Anda	dapat	merubah	format	text,	ukuran	text,	warna	text,	dan	masih	banyak	fitur	yang	lainnya.5.	Jika	sudah	langsung	Close	saja.6.	Apakah	langsung	otomatis	ada	textnya	?	Tidak.	Anda	harus
kembali	drag	and	drop	title	yang	sudah	dibuat	tadi.	Untuk	caranya	sama	saja	seperti	pada	langkah	sebelumnya.7.	Simpan	pada	bagian	atas	video	editing	Anda,	seperti	pada	timeline	dibawah	ini	terdapat	nama	“Title	01”Jangan	lupa	kita	beri	Effect	Cross	Disolve	lagi	pada	awal	dan	ujung	title.Untuk	langkah	cara	export	video,	Anda	bisa	membaca	pada
artikel	lanjutannya	yang	telah	kami	siapkan	link	dibawah.Artikel	Lanjutan	:	Cara	Export	Video	di	Adobe	Premire	ProAnda	bisa	melanjutkan	cara	edit	video	di	Adobe	Premiere	Pro	CC	dengan	melanjutkan	artikel	yang	telah	kami	sediakan.	Jika	masih	bingung	pada	penjelasan	ini	Anda	bisa	Komentar	dibawah	ini.Baca	Juga	:	Untuk	lebih	jelas	dalam
mengedit	video	dasar	untuk	pemula,	mungkin	Anda	akan	lebih	paham	untuk	menonton	video	dari	agung	hapsah	ini.	Kumpulan	Tutorial	Lengkap	Adobe	Premiere	Pro	Cs6	-	Berikut	ini,	kami	dari	Tutorial	Kreasi	Parcel	Dari	Kardus	Bekas,	dari	hasil	pencarian	file	yang	ada,	berikut	ini	kami	sajikan	informasi	terkait	Judul	:	Kumpulan	Tutorial	Lengkap
Adobe	Premiere	Pro	Cs6.	Link	lengkap	dapat	dilihat	di	:	Atau	silahkan	Anda	klik	link	tentang	Kumpulan	Tutorial	Lengkap	Adobe	Premiere	Pro	Cs6	yang	ada	di	bawah	ini.	Semoga	dapat	bermanfaat.	Demikianlah	Postingan	Kumpulan	Tutorial	Lengkap	Adobe	Premiere	Pro	Cs6	[	Sekianlah	artikel	Kumpulan	Tutorial	Lengkap	Adobe	Premiere	Pro	Cs6	kali
ini,	Semoga	dapat	membantu	dan	bermanfaat	untuk	Anda.	Kumpulan	Tutorial	Lengkap	Adobe	Premiere	Pro	Cs6	2019-11-28T21:42:00-08:00	Rating:	4.5	Diposkan	Oleh:	Tutorial	Kreasi	Parcel	Dari	Kardus	Bekas	Page	2	Adobe	Premiere	Pro	merupakan	aplikasi	pengedit	video	yang	tersedia	bagi	pengguna	OS,	Windows	dan	Linux.	Jika	kamu	ingin
memulai	karir	sebagai	video	editor	atau	mungkin	Vlogger	yang	menuntut	kemampuan	untuk	menyunting	video	maka	kamu	perlu	mempertimbangkan	menggunakan	aplikasi	ini	untuk	pekerjaan	sehari-hari.Bagi	kamu	yang	baru	belajar,	kami	berikan	tutorial	sederhana	untuk	menggunakan	Adobe	Premiere	Pro	beserta	fitur-fitur	yang	disediakan	secara
lengkap.	Baca	artikel	selengkapnya	di	bawah	ini!Mengenal	Fitur	Adobe	Premiere	ProSebelum	kamu	belajar	menggunakan	Adobe	Premiere,	alangkah	baiknya	untuk	mengenal	terlebih	dahulu	user	interface,	fitur	dan	istilah	yang	digunakan	pada	aplikasi	ini.	Lihat	gambar	di	atas	dan	berikut	ini	penjelasan	berdasarkan	nomor	yang	terterai.Project:
Merupakan	kolom	yang	berisikan	video	atau	sound.	Kamu	dapat	dengan	memindahkan	file	dari	komputer	dengan	menggesernya	ke	kolom	ini.	Otomatis	file	akan	tersedia	dan	siap	disunting.	Pada	kolom	ini	juga	kamu	dapat	mengedit	perpindahan	atau	transisi	antar	video	dan	mengedit	suara.Sequence:	Merupakan	kolom	untuk	melakukan
penyuntingan.	Kamu	hanya	perlu	menggeser	file	yang	indin	diedit	pada	kolom	project.	Kamu	dapat	menindih	sampai	dengan	3	video	dan	3	audio	sekaligus.	Pada	kolom	ini	kamu	bisa	memotong	dan	menyatukan	file.Program:	Merupakan	real	time	preview	video	yang	sedang	kamu	sunting.	Ketika	kamu	memutar	video	yang	tengah	disunting	akan
muncul	di	kolom	ini.Source:	Berisikan	info	mengenai	video	atau	sound	yang	kamu	sedang	gunakan.	Pada	kolom	ini	kamu	juga	bisa	mengedit	suara	ataupun	tone	warna	dengan	lebih	detail.Menggunakan	Adobe	PremiereSetelah	kamu	mengenal	tampilan	dan	fitur	yang	ada	pada	Adobe	Premiere.	Berikut	ini	cara	yang	dapat	kamu	ikuti	untuk	mengedit
video	serta	hal-hal	penting	yang	harus	kamu	lakukan	sebelum	proses	penyuntingan.Langkah	1:	Buka	Software	dan	Atur	ProjectUntuk	memulai	penyuntingan	video	kamu	terlebih	dahulu	harus	menentukan	output	atau	jenis	video	apa	yang	ingin	dihasilkan.	Pertama,	buka	Adobe	Premiere	Pro	CS	6	lalu	klik	‘Create	New	Project’.	Selanjutnya	pop	up
jendela	baru	muncul	dan	digunakan	untuk	memberikan	nama	file	dan	memilih	lokasi	penyimpanan.Lalu	pop	up	jendela	baru	muncul	yang	berisikan	jenis	video	yang	akan	kamu	hasilkan.	Kamu	dapat	memilih	beragam	jenis,	misalnya	khusus	untuk	mengunggah	di	Youtube	akan	tersedia	beragam	format	khusus	Youtube.Paling	standar	kami	sarankan
memilih	‘DSLR	1080p’	bila	kamu	merekam	menggunakan	DSLR.	Dengan	resolusi	ini	kamu	dapat	menghasilkan	video	yang	bagus.	Beri	nama	sequence.	Terakhir,	klik	‘OK’.Langkah	2:	Memindahkan	FileLangkah	berikutnya	kamu	perlu	memindahkan	file	video	dan	audio	pada	panel	Project	dengan	cara	menggeser	file	dari	komputer	ke	kolom	tersebut.
Setelah	semua	file	ada	di	panel	tersebut	kini	kamu	bisa	melakukan	proses	penyuntingan.Sebelumnya,	kami	sangat	menyarankan	kamu	untuk	memberikan	nomor	atau	tanda	susunan	video	dan	audio.	Ini	sangat	membantu	kamu	dalam	proses	penyuntingan.	Karenanya	buatlah	storyboard	atau	outline	cerita	terlebih	dahulu.Langkah	3:	Proses
Penyuntingan[Sumber:	]Untuk	melakukan	proses	penyuntingan,	geser	file	dari	panel	‘Project’	ke	panel	‘Sequence’.	File	video	yang	diletakkan	di	panel	tersebut	akan	mengandung	dua	format,	yaitu	video	dan	audio.	Bila	kamu	menggunakan	audio	eksternal	maka	bisa	pindahkan	audio	di	kolom	audio	1	dengan	menghapus	audio	bawaan.	Caranya:Klik
kanan	pada	file	di	‘Sequence’	lalu	pilik	‘Unlink’.	Otomatis	file	video	dan	audio	akan	terpisah	dan	dapat	kamu	delete	dengan	klik	audio	1	dan	tekan	‘delete’	di	keyboard.Di	bagian	squence	ini,	kamu	bisa	memotong	adegan	demi	adegan.	Caranya	mudahnya	klik	‘C’	di	keyboard	dan	lalu	tekan	enter	di	keyboard	pada	adegan	yang	ingin	kamu	potong.	Hapus
bagian	yang	tidak	ingin	digunakan.Lakukan	ini	terus	menerus	lalu	satukan	adegan	demi	adegan.	Hal	ini	berlaku	pula	pada	file	audio.	Pastikan	kamu	memutar	preview	terus	menerus	agar	menghindari	ada	video	atau	audio	yang	belum	masuk	atau	tidak	sinkron	satu	sama	lain.Untuk	mempermudah	dalam	mengedit.	Berikut	ini	beberapa	keyboard
shortcuts	yang	dapat	kamu	digunakan:Project:	CTRL+ALT+N	(Windows)	;	Opt+Cmd+N	(Mac)Sequence:	CTRL+N	(Windows)	;	Cmd+N	(Mac)Open	Project:	CTRL+O	(Windows)	;	Cmd+O	(Mac)Close	Project:	CTRL+SHIFT+W	(Windows)	;	Control+Cmd+W(Mac)Save:	CTRL+S	(Windows)	;	Cmd+S	(Mac)Save	as:	CTRL+SHIFT+S	(Windows)	;
	Control+Cmd+S	(Mac)Undo:	CTRL+Z	(Windows)	;	Cmd+Z	(Mac)Redo:	CTRL+SHIFT+Z	(Windows)	;	Shift+Cmd+Z	(Mac)Cut:	CTRL+C(Windows)	;	Cmd+C	(Mac)Paste:	CTRL+V(Windows)	;	Cmd+V	(Mac)Mengedit	memang	memerlukan	kesabaran!Langkah	4:	Rendering[Sumber:	openlab.citytech.cuny.edu]Jika	video	telah	kamu	sunting	dan	jadi
menjadi	cerita	yang	utuh.	Maka	saatnya	melakukan	proses	rendering.	Berbeda	dengan	file	edit	foto	yang	hanya	tinggal	‘Save	As’	saja,	untuk	menghasilkan	video	panjang	diperlukan	proses	penyatuan	yang	dikenal	dengan	istilah	render.Proses	ini	memakan	waktu	cukup	panjang	tergantung	dari	durasi	dan	kualitas	konten	yang	ingin	dihasilkan.
Semakin	rumit	proses	pengeditan	niscaya	proses	rendering	akan	bisa	berjam-jam.	Pastikan	komputer	atau	laptop	kamu	memadai	yah!Untuk	melakukan	render	klik	‘File’	yang	terletak	di	pojok	kiri	atas.	Selanjutnya	pilih	‘Export’	dan	‘Media’.Pop	up	jendela	pengaturan	akan	muncul.	Kamu	akan	diminta	mengatur	format	video	(.mp4,	.avi,	.3gp,	dsb).	Jika
ingin	menghasilkan	kualitas	terbaik	centang	pilihan	‘Use	Maximum	Render	Quality’.Bila	sudah	yakin	dengan	pengaturan	silahka	klik	‘Export’.	Maka	proses	rendering	akan	berjalan.	Tunggu	sampai	100%.Nah,	itu	dia	cara	singkat	menggunakan	Adobe	Premiere	CS	6.	Sekarang	gak	ada	alasan	lagi	buat	kamu	untuk	menunda-nunda	belajar	mengedit
video	sendiri.
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